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Iowa Department of Transportation Customized 
SiteXchange User’s Guide Supplement 

In an effort to fully interface AASHTO Trns•port® software with its existing systems and 
processes, the Iowa Department of Transportation requested the Subcontract Request and 
Approval Form in the generic Trns•port SiteXchange® software to be customized.  
Enhancements were completed in the Miscellaneous Data Screen, Subcontract Request and 
Approval Report, Subcontractors Sub-Header Screen, and Subcontractors Detail Screen. 

There were no changes made to the Trns•port LAS® to SiteXchange interface. 

These new screens and fields are used to specify that a contractor acknowledge all the comments 
before submitting the form; confirmation or denial of Division of Labor registration and phone 
number for each subcontractor; and the input of a dollar amount paid to DBE subcontractor or 
material supplier for each subcontract item.  

Users will follow these steps to invoke this custom process: 

At the DOT: 

1. Use Trns•port LAS  to create contract.csv and Vendor.dat export files. 

2. Use SubGen to Create Contract files like this (from command line): 

C:\SiteXchange\SubGen\> SubGen contract.csv 

This will create one or more contract files (*.con). 

3. Use SubGen to Create Reference file(s) like this (from command line): 

C:\SiteXchange\SubGen\> SubGen /Encrypt Vendor.dat 

This will create a Vendor.bin file. 

4. The *.con and *.bin files are transferred to contractor. 
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At the Contractor's office: 

1. Use SubCon to load a contract file. Add subcontractors and all related information. 

2. Sign in the Miscellaneous Data folder after reading all the comments. 

3. Click on yellow check mark button or select Check Contract from the Tools menu to 
confirm that no errors exit. 

4. Select Print from the File menu to print the report. 

5. Use SubCon to create a Contract file like this(from command line): 
c:\sitexchange\subcon\>subcon <contract file name>   
This will create the Subs.dat file.  

Miscellaneous Data Screen 
After the Subcontractors and, if necessary, items associated to the subcontractor have been 
added, then the contractor will sign in the Miscellaneous Data folder after reading all the 
comments. This assures that the contractor has acknowledged all the comments before 
submitting the form.  

The text on the Miscellaneous folder screen has changed from the generic SiteXchange.  

Verifying the Misc Data Screen 

After reading the comments, the contractor will select Yes on the dropdown menu to 
acknowledge the customized text determined by IADOT is true and correct to the best of its 
knowledge.  

 

Figure 1.  MISC Screen 
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Subcontract Request and Approval Report 

The Subcontract Request and Approval Report has been customized for the agency as follows: 

1. A new totals section has been added to the header (front) of the report, including 
Number of subcontractors, Total Contract Amount, Total Subcontractor Amount 
Entered, and Total Subcontractor % of Contract Entered. 

2. Added A: column and a total is calculated and displayed. 

3. Added a percent field calculated as the percent of the total contract amount that the 
Subcontractor represents by adding all its Subcontract items. 

 

Figure 2.  Sub Request Form Front Page Example 

Iowa Department of Transportation 
 

SUBCONTRACT REQUEST AND APPROVAL 
 

Contractor: IA Contracting Service       County: Madison    
Contractor Identification Number: 12345                Contract ID No.: C12234 
(Number used on employers quarterly Federal Tax return U.S. Treasury Dept. Form 941) 
Letting Date: 11/11/11                                 Bid Order:14 
 
------------------------------------------------------------------------------------- 
 
Number of subcontractors: 
11 
 
Total Contract Amount: 
500,000.00 
 
Total Subcontractor Amount Entered: 
350,000.00 
 
Total Subcontractor % of Contract Entered: 
30 
 
------------------------------------------------------------------------------------- 
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Figure 3.  Sub Request Form Detail Page Example 

The report has been customized so the user can provide confirmation or denial of Division of 
Labor registration and a phone number for each subcontractor; provide contract language and 
conditions; display a dollar amount paid to DBE subcontractor or material supplier for each 
subcontract item (column A) as well as a total and summary information.  

SUBCONTRACT REQUEST AND APPROVAL 
 

Contractor: IA Contracting Service           County: Madison    
Contractor Identification Number: 12345          Contracts ID No.: C12234 
(Number used on employers quarterly Federal Tax return U.S. Treasury Dept. Form 941) 
Letting Date: 11/11/11                              Bid Order:14 
 
This is to request that the following subcontractor be approved to perform the work for the 
items listed below. It is clearly understood by both the prime contractor and the subcontractor 
that all terms of the prime contract shall apply. It is also clearly understood that the 
subcontractor is not a third-party beneficiary of the contract between the prime contractor and 
the DOT. 
 
When this subcontractor is being used to satisfy an established DBE goal, the actual amount to 
be paid to the DBE is indicated in Column A Col. The approval of the DOT is limited to the 
question of whether the subcontractor is a DBE and shall in no sense be construed as an 
endorsement of the DBE or an expression of opinion by the DOT on the subcontractor's ability to 
comply with the contract. 
 
Subcontractor: Water Removal Systems     Subcontractor Number: 3456 
                (Federal Tax Return U.S. Treasury Dept. Form 941) 
Address: 1234 NW Testing Ave.                  Division of Labor Registration: Yes  
     Small Town, IA 12345                  Telephone No.: 333-222-2345 
 
The following conditions apply if this is a Federal Aid Contract: 
1. The prime contractor is responsible for compliance by the subcontractor with Required 
Contract Provisions for Federal Aid Contracts, Form FHWA-1273, dated as per contract, relative 
to projects financed under the Federal Highway Act relative to wages and payrolls, and all terms 
of the prime contract applicable to the work performed by the subcontractors. A copy of FHWA-
1273 shall be attached to the subcontract. 
2. The prime contractor is responsible for checking and submitting subcontractor's payrolls at 
the same time the prime contractor's payrolls are submitted when payment of predetermined wages 
is required. 
3. I do hereby certify that in requesting approval to sublet a portion of this project we have 
taken affirmative action to seek out and consider disadvantaged business enterprises as 
potential subcontractors and/or material suppliers. 
 
Line       Unit                                 Part. 
No.  Item Description  Quantity  Price       A Col       $ Amount     Item 
-------------------------------------------------------------------------------------- 
1. Mobilization   1     250,000.00  100,000.00    250,000.00    Y              
-------------------------------------------------------------------------------------- 
Signature (Prime Contractor)               Totals:     100,000.00  (a)250,000.00 
 
-------------------------------------------------------------------------------------- 
 
Contract Amount (b)                                                      Pct. Sublet  
                                                                         (a/b)*100 
-------------------------------------------------------------------------------------- 
500,000.00                            50 
-------------------------------------------------------------------------------------- 
Article 1108.01 of the Standard Specifications requires the contractor to submit “Subcontract 
Request and Approval" to the Contracting Authority with the signed contract. Any additional 
subcontractor requests or changes after the contract has been signed should be submitted to the 
Project Engineer with the justification as required by the Iowa Code. 
 

                      Page 2 
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The report header page contains: 

 general contract information, 

 the number of subcontractors,  

 the total contract amount, 

 the total subcontractor amount entered, 

 the total subcontractor % of contract entered.  

Sub Request Form Detail Page contains: 

 Contract language and conditions 

1. Subcontractor general information 

2. List of items associated to subcontractor by: 

item,  

quantity,  

unit price,  

 The actual dollars paid to Disadvantaged Business Enterprise (DBE) subcontractors 
or material suppliers for each item 

1. Indication if the item is a Partial Item 

2. Summary information consisting of subitem total amount for each subcontractor 
and the total contract amount (b) 

3. Percentage sublet per subcontractor (a/b)*100 

This custom process will produce the report in portrait format.   

Subcontractors Sub-Header Screen  
Subcontractors Sub-Header Screen includes two new fields.  The first is the subcontractor’s 
phone number, which is prepopulated from the vendor file. The other field is the Division of 
Labor Registration, which is indicated with a Yes or No for each subcontractor.  
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Adding Subcontract Information 

To add a subcontractor to the contract, click on the contract folder in the tree view and select 
Add Subcontractor from the Edit menu. You can also add a subcontractor by clicking on the 
Subcontractors folder and selecting Add Subcontractor from the right mouse button menu.  

SubCon adds a new folder to the list of subcontractors for the contract in the left pane and 
displays text boxes for adding new subcontract information in the right pane.  

 

Figure 4.  New Subcontractor Folder in Tree View  

If the subcontractor is already listed as a vendor in SiteXchange, enter the subcontractor’s name 
or ID number or click the down arrow to display a list of registered vendors. SubCon will 
automatically advance the list to that name. Click on the name to select it and SubCon enters 
information for that vendor into the remaining text boxes, including the telephone number.  

If the name of the new subcontractor is not in the list, type the name in the Name text box and 
press TAB to move to the next text box to fill in the remaining information. 

Complete the subcontractor record by entering information into these remaining fields:  

Division of 
Labor 
Registration 

Confirmation or denial of Division of Labor registration for each subcontractor. 
Choices are Y or N.  

Sub Type  This field contains a list of valid codes for subcontractor classifications. Certain 
sub types require that a subcontract amount be used instead of contract items to 
calculate the bid. When these sub types are chosen, you must also enter an 
amount in the Subcontract Amount field to create a complete record.  

Type of 
Work  

This field contains a list of valid codes for work classifications. The choices 
available depend on the selected subcontractor.  
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Notes  Miscellaneous comments may be added to the record in this field. These are not 
used in processing.  

Select Save from the File menu to save the new subcontractor record.  

Subcontractors Item Detail Window 
The upper section of the window contains a scrollable list of all the items that can be 
subcontracted. A new column has been added labeled A Col. The column is populated based 
upon the input field A Col on the lower portion of the screen. The contractor can input the actual 
dollar amounts paid to DBE subcontractors or material suppliers for each item in the A Col field.  

 

Figure 5.  Subcontractors Item Detail Window 

When a new item is added to a subcontractor, the A Col field will default to zero. The A Col 
field will appear on the customized Subcontract Request and Approval Report and be used in 
calculations.  

Adding Items to Subcontractor 

To subcontract an item to a vendor, select the item from the list in the upper section of the 
Subcontractor Item window, and select either the check box in the Use? column in the upper 
section of the window or the check box labeled Subcontract this item to this vendor in the 
lower section of the window. Modify any values in the lower portion of the screen if necessary.  

Fill out the A Col field based on the actual dollar amounts paid to DBE subcontractors or 
material supplier for the selected item. When saving the record, the A Col column will update 
with the input dollar amount.  
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